
Reports

This chapter describes the reporting features of Account Management, including activity

statements, trade confirmation reports and supplemental reports such as margin reports.

This chapter includes the following topics:

Activity Statements

Trade Confirmation Reports

PortfolioAnalyst

Transaction Cost Analysis

Risk

Supplemental Reports

Tax

Settings

Customer Activity Monitor (CAM)

Activity
The Reports > Activity menu includes the following pages:

Statements - View and create activity statements. You can run default statements or create

your own customized statements.

Third-Party Downloads - Download activity statements in one of several formats, such as

Quicken.

Flex Queries - Create highly customized activity statements in text or XML format.

Batch Reports - View the status of reports queued for batch processing, and run batch

reports.

Models - Advisors and their clients view Model Statements.

3
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About Activity Statements

Activity Statements include information about your account activity, which can be generated on

a daily, monthly, and yearly basis for all accounts.

Information included in an Activity Statement is presented in expandable and collapsible

sections with click-down detail, and you can create customized statements to include or

exclude individual sections. You can also choose to include closed accounts in your statement.

You are notified via email when there is account activity.

Activity Statements in Mobile Account Management include information about your account

activity, which can be generated on a daily or monthly basis and for a custom date range for all

accounts.

Prices in statements are displayed with a minimum of four decimal places to a maximum of

seven decimal places. Sections that display price include Trades and Open Positions.

Statement Cutoff Times

The statement cutoff time for commodities is generally 5:15 PM EST, and the statement cutoff

time for securities is generally 8:20 PM EST. This means that any trades executed for those

asset classes before the cutoff times will be reflected in your statement for the day.

IB-JP clients have a statement cutoff time of around 6:00 AM ET.

Activity by Account Type

The following figure shows what kind of activity statements are available for each account type.
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Chapter 3 Activity Statement Archive Policy

Activity Statement Archive Policy

We provide access to activity statements as follows:

Daily account statements are available for the four previous calendar years and from the

start of the current calendar year.

Monthly account statements are available for the five previous years (60 prior months).

Annual account statements are available for the five previous years.

Custom Date Range account statements are available for the four previous calendar years

and from the start of the current calendar year.

You can obtain account statements older than this for a processing fee. See the Other Fees

page on our website for more information.

Viewing Activity Statements

Activity Statements include information about your account activity, and can be generated on a

daily, monthly, and yearly basis for all accounts.

You view activity statements from Account Management or from the View menu in Trader

Workstation. Make a note of the following guidelines when viewing activity statements:

Multi-account structures (Advisor, Broker, Institutions) can select one or more accounts from

the Account(s) list.

Monthly statements are generally available by five business days after the close of a month.

Annual statements are available by January 31 under normal circumstances.

Who can access the Statements page?

You can access this page if you are a(n):

Individual, Joint, Trust or IRA Account User

Small Business Account User

Friends and Family Group Master or Client User

Advisor Master User Individual

Advisor Master User Organization
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Advisor Client User Individual

Advisor Client User Organization

Proprietary Trading Group Master User

Proprietary Trading Group Sub User

Broker Master User (master account only)

Broker Fully Disclosed Client User

Broker Fully Disclosed Client User Organization

Broker Non-Disclosed Client User

Investment Manager Master User

Fund

and you have been granted Reporting access rights.

Default Statements

There are several default statements available for viewing Activity Statements:

Partition Summary - This default statement is available for account holders who have

divided their accounts into partitions. It contains summary sections at the top for each par-

tition, followed by concatenated statements for each partition.

Default -The primary default statement. It includes Net Asset Value (NAV), Realized and

Unrealized and Mark-to-Market (MTM) performance summaries, deposit and withdrawals,

dividends, interest, fees, and other summary information related to changes in NAV. This

default statement supports the Calendar Year period. For accounts with models, the Default

statement includes a Model Summary at the top of the statement followed by the full Activity

Statement for the account.

Realized Summary -A simpler statement that includes NAV, Positions and realized P&L

summaries as well as other summary information related to changes in NAV.

MTM Summary - A simpler statement that includes NAV and Position and MTM profit and

loss summaries as well as other summary information related to changes in NAV.

Commodities Regulatory - The Commodities Regulatory statement breaks out domestic

(US) and foreign cash/holdings for the Commodities segment of your account (required by
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Chapter 3 Default Statements

the CME Group). This type of statement is available for any accounts that trade futures or

futures options.

You can also select one of our legacy default statements:

Legacy Full - This statement includes ALL sections of an activity statement; this is the only

default statement that supports the Yearly period.

Legacy Simple - A simpler statement that includes details but excludes MTM P&L.

Legacy Summary - A simple summary statement that includes only a few sections.

Multi-Account Summary - A summary statement for linked accounts and multi-account struc-

tures.

To view an activity statement from Account Management

1. Click Reports > Activity > Statements.

The Statements page appears by default.

If you have a multiple account structure such as an institution account or multiple linked

accounts, use the Account Selector at the top of the page to select one or more accounts

on which to report. To include activity from accounts you have recently closed, select the
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Include Closed Accounts check box. If you choose to include closed accounts, those

accounts appear in the Account Selector.

2. In the Statements list, select the default statement or one of your own saved customized

statements that you want to view.

3. In the Date(s) fields, select the Period (Daily, Custom Date Range,Monthly or Calendar

Year) and a Date.

o For Custom Date Range, select the From and To dates, which define the period

covered by the statement.
o For Daily statements, you can select a specific date or the last business day.
o For Monthly statements, you can select the last month or a specific month.
o For Calendar Year (annual) statements, you can select a specific year.
o For Commodity Regulatory Statements, you can select Daily or Custom Date Range.

Data is available from 5/29/2015 forward.

4. If you have a multiple account structure, selected more than one account in the Account

Selector, and want to view a consolidated statement, select the Consolidate Selected

check box. This check box ONLY appears if you selected more than one account in the

Account Selector (or if you selected one or more accounts in a Household in the selector).

You can also generate statements for all accounts in a single statement (multiple state-

ments are joined together in a single statement) if you select your own master account in

the Account Selector and then select the Concatenate All check box.

Advisors, Money Managers and Brokers and master account users with reporting access

rights who select their own master account in the Account Selector have access to client-

only consolidated and concatenated statements. Select Consolidated (Clients-Only) to

generate activity data for all clients combined into a single statement, or Concatenate All
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Chapter 3 Default Statements

(Clients-Only) to generate statements for all client accounts in a single statement

(multiple client statements are joined together in a single statement).

5. In the Format list, select either HTML/WEB, PDF, CSV or Excel (Legacy), depending on

how you want to view the statement. For our clients who want a format compatible with

Microsoft Excel, we recommend selecting CVS; however, we will continue to make the

Excel (Legacy) format available.

6. In the Language list, select your desired language.

7. Click View to generate the activity statement.

If you selected PDF as the Format, you will be prompted to open the generated report or

save it to your computer.

8. You can expand and collapse each section of the statement individually. Click the slate

blue section heading bar to expand a section, and click it again to collapse it.
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Creating Customized Statements

We let you create and save customized statements that enable you to exclude unnecessary

information from activity statements. Customized statements let you select only those sections

that you want to include in your activity statement, as well as additional statement options. If you

want your customized statements delivered by email or FTP on a daily or monthly basis, you

can also select delivery settings to be saved with the statement.

To create a customized statement

1. Click Reports > Activity > Statements.

The Statements page appears by default.
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Chapter 3 Creating Customized Statements

2. Click the Customize Your Statements bar to expand that section.

3. In the Create New/Select to Edit list, select Create New, then enter a name for the state-

ment in the Statement Name field, or select one of the default statements as the basis for

your customized statement (Default, MTM Summary, Realized Summary or Multi-Account

Summary).
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4. You can also edit an existing statement and save it under a new name. To edit an existing

customized statements, select it from the Create New/Select to Edit list.

4. Select the check box next to each section you want to include in an activity statement.

Select ALL to include all sections in your customized statement.

5. In Optional Sections, select the check box next to each section you want to include in your

statement.

6. In Section Configurations, select the check box next to each option you want to apply to

your statement.

7. In the Profit and Loss list, select the profit and loss format for the statement. SelectMTM

and Realized P/L, Realized P/L Only,MTMOnly, or None.

8. Select one of the following from the Statement Type list:

9. If you are an Executions Services customer, select either Activity Statement or Execution

Settlement.

Execution Settlements show activity by settlement date instead of trade date. If you select

Execution Settlement, filter the settlement by broker name or broker account using the

fields provided.

10. If you are a Prime Services customer,select Activity Statement, Settlement or Projected

Settlement. Prime Settlements show activity by settlement date; Projected Prime Set-

tlements show activity by projected settlement date.
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Chapter 3 Creating Customized Statements

11. If you want to view your statements on your mobile device, in the Statement Type list,

selectMobile Summary. The Mobile Summary is a scaled-down statement designed to be

viewed on a mobile device.

12. In the Customize Statements Delivery Settings section, specify additional information for

customized activity statement that you want to be sent via email. Enter the following inform-

ation for customized statements that will be delivered via email:

o Account: Select account ID, ALL or CONSOLIDATED. Select ALL to apply the state-

ment to the master account and all sub accounts (or linked accounts). A separate email

will be sent for each account. (If you select FTP on the Delivery Settings page in Report

Management, all files will be delivered to the FTP site, but the directory will be appen-

ded with the report date for organizational purposes.)

Although email and FTP delivery methods are available, we recommend that Advisors

and Brokers choose FTP as their delivery method for customized statements with ALL

accounts selected. Advisors and Brokers who select email as the delivery method for

customized statements with ALL accounts selected, you will get an emailed statements

for each client or sub account.
o Activity Period: Select Daily or Monthly.
o Format: Select HTML/WEB, PDF or Excel.
o Language: Select your language from the list.

13. Click Save to save your statement template.
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Your customized statement will now appear in the Available Statements drop-down in the

View Statements section of the page.

Customized Statements Profit and Loss Selection

When you create a customized statement, you can select one of the following Profit and Loss

options:

MTM and Realized P/L

Realized P/L Only

MTM Only

None

Your selection affects which sections and which columns appear in certain sections in your

statement. Note that default statements use the MTM and Realized P/L Profit and Loss setting.

The following figure shows how your profit and loss selection affects customized Activity

Statements.
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Chapter 3 Third-Party Downloads

Third-Party Downloads

The Activity Downloads page lets you download daily and monthly activity statements into any

one of the following software:

Microsoft Word

Microsoft Money

Quicken

Tradelog

GainsKeeper

Captools (Legacy)

In addition, the following downloads are available upon request:

Daily Captools Downloads - Daily Captools downloads are available for customers upon

request. Send your request to enable Captools downloads to reportingin-

tegration@interactivebrokers.com. Note that Captools downloads are not available to Non-

Disclosed Broker Clients. If you request Daily Captools Downloads, the Activity Downloads

page will contain an additional section for Daily Captools Downloads.

Daily PortfolioCenter®/MorningstarDownloads for Advisors (for advisor accounts only).

PortfolioCenter is a product of Schwab Performance Technologies, a subsidiary of The CharlesSchwabCorporation.

If you are downloading your statements for use in a proprietary program that requires a set

format, use Activity Flex Queries instead of Activity Downloads.

Who can access the Activity Downloads page?

You can access this page if you are a(n):

Individual, Joint, Trust or IRA Account User

Small Business Account User

Friends and Family Group Master or Client User

Advisor Master User Individual

Advisor Master User Organization

Advisor Client User Individual

Account Management Users' Guide 91



Advisor Client User Organization

Proprietary Trading Group Master User

Proprietary Trading Group Sub User

Broker Master User (master account only)

Broker Fully Disclosed Client User

Broker Fully Disclosed Client User Organization

Investment Manager Master User

Fund

Administrator who is subscribed (linked) to a client account.

To download activity statements

1. Click Reports > Activity > Downloads.

If you have a multiple account structure such as an institution account or multiple linked

accounts, use the Account Selector at the top of the page to select an account on which to

report. To download a statement for a closed account, select the Include Closed

Accounts check box, and then select the closed account.

The Account Selector is closed once you select an account. To change the selected

account, click the tab to open the Account Selector, and then click a different account.

2. Make the following selections:

o In the Date fields, select the Period (Daily, Monthly or Custom Date Range) and a Date.

For Custom Date Range, select the From and To dates, which define the period

covered by the statement you want to download. Note that downloads to Quicken

(.OFX format) can go back 90 days.
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Chapter 3 Third-Party Downloads

o Select a download format from the Format drop-down. Advisors can download to Port-

folioCenter/Morningstar; they can download all six files in a single zip file.

3. Click Download.

A new browser window opens, informing you that the report was generated successfully.

4. Open the generated report with the appropriate application, or download the report to your

computer.
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If You are Downloading a Zip File Using Internet Explorer 7 or 8

If you are downloading a Zip file using Internet Explorer 7 or 8, verify that automatic prompting

for file downloads is enabled.

To verify that automatic prompting for file downloads is enabled

1. In Internet Explorer, select Internet Options from the Tools menu.
2. In the Internet Options dialog box, select the Security tab.
3. Click the Custom Level... button.
4. Scroll down to the Downloads section.

5. Automatic prompting for file downloads should be enabled.

Activity Flex Queries

The Activity Flex Queries page lets you create highly customized report templates for activity

statements. Flex queries let you specify exactly which fields you want to view in your Activity

Statement, the time period you want the report to cover, the order in which you want the fields to

display, and the display format, TEXT or XML, in which you want to view your report.

You can create multiple Flex Queries with different fields for each statement. All of your Flex

Queries are stored in Account Management, and can be easily run from the Activity Flex

Queries page. An activity Flex Query is different from a customized activity statement in that you

can customize a Flex Query at the field level, allowing you to include and exclude detailed field

information. Customized statements only let you include and exclude sections.

The Flex Queries page lets you create a new Flex Query or edit an existing Flex Query.

Existing Flex Queries are displayed in the Saved Flex Queries section of the page. You can

also edit default Flex Queries for Trades and Positions, then use those queries as the basis for

your own Flex Queries.

Saved Flex Queries are available for the four previous calendar years and from the start of the

current calendar year.

Who can access the Flex Queries page?

You can access this page if you are a(n):
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Chapter 3 Activity Flex Queries

Individual, Joint, Trust or IRA Account User

Small Business Account User

Friends and Family Group Master or Client User

Advisor Master User Individual

Advisor Master User Organization

Advisor Client User Individual

Advisor Client User Organization

Proprietary Trading Group Master User

Proprietary Trading Group Sub User

Broker Master User (master account only)

Broker Fully Disclosed Client User

Broker Fully Disclosed Client User Organization

Investment Manager Master User

Fund
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To create an activity Flex Query

1. Click Reports > Activity > Flex Queries.

2. Do any of the following:

To create a new query, click Create New Flex Query.
To run an existing query, click Run for the query.
To edit an existing query, click Edit for the query, then make your changes to the query and

click Save Query.
To delete an existing query, click Delete.
To add the Default Trades query, click Create Default Trades Query.
To add the Default Positions query, click Create Default Positions Query.

Note that when you add a default query to the list, the button disappears from the page. If

you delete a default query from the list, the button re-appears.
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Chapter 3 Activity Flex Queries

3. If you clicked Create New Flex Query, a new page appears on which you create your

new Flex Query.

If you have a multiple account structure such as an institution account or multiple linked

accounts, use the Account Selector at the top of the page to select one or more accounts

on which to report. To include activity from accounts that you have recently closed, select

the Include Closed Accounts check box. If you choose to include closed accounts,

those accounts appear in the Account Selector.

4. Make selections and set options in the General Configuration and Date Configuration sec-

tions.
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In the Query Name field, enter the name of the Flex Query.

In the Output Format list, select Text or XML. If you select Text, you must also choose a

delimiting character (comma, pipe or tab character), and optionally choose to include header

and trailer records; column headers; and section code and line descriptors.

Select other options as required. Note that the Consolidated and All options are only avail-

able when the master account has been selected in the Account Selector.

In the Date Configuration section, select the period for the Flex Query, or enter a range of

dates in the From Date and To Date fields. The following periods are available:

Last Business Day

Last Month

Last 30 Calendar Days

Last 365 Calendar Days

Month to Date
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Year to Date

Last Business Week (Mon-Fri)

Last N Calendar Days (when you select this option, you must then select a number from 1 to

365 from a drop-down)

In the Date Configuration section, select a Date Format, Time Format and Date/Time Separ-

ator:

Available date formats are:

yyyyMMdd (default)

yyyy-MM-dd

MM/dd/yyyy

MM/dd/yy

dd/MM/yyyy

dd/MM/yy

dd-MMM-yy

Available time formats are:

HHmmss (default)

HH:mm:ss

Available date/time separators are:

; (semi-colon, the default)

, (comma)

'' (single-spaced)

No separator
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Advisors, Money Managers and Brokers and master account users with reporting access

rights who select their own master account in the Account Selector have access to client-

only consolidated and concatenated statements. Select Consolidated (Clients-Only) to

generate activity data for all clients combined into a single statement, or Concatenate All

(Clients-Only) to generate statements for all client accounts in a single statement (multiple

client statements are joined together in a single statement).

5. Advisors who have created models in Trader Workstation can include model information

in their Activity Flex Queries. In the Models section of the page, select one of these

options:

o All - Include data for all models joined together. If you select this option, accounts that

do not have models will also be included.
o Consolidated - Include consolidated data for all models and a single account.
o Select a Model - Select this check box to view available models in the Model drop-

down list. Select a model from the drop-down to view a statement for a single model.

Only models that have been created in Trader Workstation for the selected account(s)

will appear. If you select the Independent model, accounts that do not have models will

also be included.

6. To specify which fields in which sections to include, click each section to expand it, then

select the fields to include in the Flex Query in each section by highlighting the fields in

the Fields Available list, then using the green right arrow to move the fields to the Fields

Included list. Use the green left arrow to move fields from the Fields Included list (and

exclude the fields from the report).
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7. Click Save Query.

The saved query will now appear in the list of saved queries on the Activity Flex Queries page.

For more information

Users' Guide

Activity Flex Query Reference

Batch Reports

Requests for Activity Statements and Activity Flex Queries with a large amount of activity are

placed in a queue for batch processing. Specifically, any Activity Statement or Activity Flex

Query request that includes over 20,000 activities (activities are mostly trades but can also

include transfers, dividend payments, corporate actions, etc.) or over 250 accounts will be

automatically submitted for batch processing. If you try to view one of these reports, you will

receive a message indicating that it has been submitted for batch processing.

Note:We no longer batch-process statements that are larger than 100 MB due to

problems that this causes on our web server. You can request that your account be
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configured for FTP delivery of such statements by contacting us at

reportingintegration@interactivebrokers.com.

You can view the status of these requests on the Batch Reports page. Activity Statements and

Activity Flex Queries listed on the Batch Reports page have one of the following statuses:

Queued - The report has been placed in the queue and will be generated as soon as pos-

sible.

In Progress - The report is currently being generated.
Completed - The report has been generated and can be viewed/downloaded. Completed

batch reports are available for seven days.

Failed - The report generation failed.

To view the status of reports queued for batch processing
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1. Click Reports > Activity > Batch Reports.
2. Any report with a status of Completed can be viewed and/or downloaded immediately.

Click the View link to view an HTML or PDF report or download a PDF report or Flex

Query.

3. If a batch report has a status of Failed, try running the report again. If it fails again, contact

 Customer Service.

4. Click the Refresh link in the lower right corner of the page to refresh the list of available

batch reports.

Models

Models provide an efficient method for advisors to manage multiple trading strategies for their

clients without requiring them to open multiple accounts. Client investments are allocated

among instruments in the Model based on the Model's allocation ratios as defined by the

advisor.

Advisors and their clients can view Model Statements in Account Management on the Models

page, provided models have been created in Trader Workstation. Model Statements include

additional information about the selected model in the Account Information section.

Who can access the Models page?

You can access this page if you are a Financial Advisor, a Money Manager or an Advisor

Client, or a Fund Investment Manager or a Fund AND models have been created and saved in

your trading platform.

To view a Model statement

1. Click Reports > Activity > Models.

If you have a multiple account structure such as an institution account or multiple linked

accounts, use the Account Selector at the top of the page to select an account on which to

report. To view a model statement for a closed account, select the Include Closed

Accounts check box, and then select the closed account.
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The Account Selector is closed once you select an account. To change the selected

account, click the tab to open the Account Selector, and then click a different account.

2. In the Period field, select Daily, Custom Date Range orMonthly.

3. In the Date field, select a date or a month, depending on your Period selection. If you

selected Custom Date Range, enter a From and a To date.

4. In the Format field, select either HTML/WEB or PDF, depending on how you want to view

the statement.

5. In the Language field, select your desired language.

6. Select options:

o Consolidated - View a consolidated Model Statement for all models and a single

account.
o Concatenate All - View a Model Statement that shows data for all models joined

together in a single statement.
o Summary - View a Model Summary statement that summarizes data for all models for

one or more accounts.
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o Select a Model - Select this check box to view available models in the Model drop-

down list. Select a model from the drop-down to view a statement for a single model.

Only models that have been created in Trader Workstation for the selected account(s)

will appear.

7. Click View to generate the statement.

Quarterly Summaries

The Quarterly Summaries page lets advisor clients generate a Brokerage Account Quarterly

Activity Summary, which is a simplified activity statement for quarterly periods. Advisor Masters

can view quarterly summaries for their clients. Each quarter you will receive a hard-copy of the

summary by mail. Using the form on this page, you can download the summary in PDF format.

There are two versions of the Quarterly Advisor Client Activity Summary - a default version and

a version for Advisors who have been granted additional advisor authorizations ("full-service"

advisors).

The Quarterly Summary PDF includes the following sections:

Account Information

Net Asset Value including Change in NAV

Open Positions

Trades

Deposits and Withdrawals (for Advisors who have been granted additional advisor author-

izations only)

Other Information

Codes

Who can access the Quarterly Summaries page?

You can access this page if you are a(n):

Advisor Master User Individual (view only)

Advisor Master User Organization (view only)
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Advisor Client User Individual

Advisor Client User Organization

To view a quarterly summary

1. Click Reports > Activity > Quarterly Summaries.

If you are an Advisor Master User, use the Account Selector at the top of the page to

select an account on which to report.

The Account Selector is closed once you select an account. To change the selected

account, click the tab to open the Account Selector, and then click a different account.

2. In the Date field, select the fiscal quarter.

3. Click View to generate the summary.

The quarterly summary is generated and displayed as a PDF file in a new browser win-

dow.

Trade Confirmations
The Trade Confirmations menu includes the following tabbed pages:
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Reports - View trade confirmation reports.

Trade Allocations - View pre-trade and post-trade allocation details.

Flex Queries - Create highly customized trade confirmation reports in text or XML format.

Real-time trade confirmations are generated for all executions. You can view a trade

confirmations report, which lists trade confirmations separately by asset class.

Trade confirmations are available for the four previous calendar years and from the start of the

current calendar year.

Who can access the Trade Confirmations page?

You can access this page if you are a(n):

Individual, Joint, Trust or IRA Account User

Small Business Account User

Friends and Family Group Master or Client User

Advisor Master User Individual

Advisor Master User Organization

Advisor Client User Individual

Advisor Client User Organization

Proprietary Trading Group Master User

Proprietary Trading Group Sub User

Broker Master User (master account only)

Broker Fully Disclosed Client User

Broker Fully Disclosed Client User Organization

Investment Manager Master User

Fund

and you have been granted Reporting access rights.

Trade Confirmation Reports

To generate a trade confirmation report
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1. Click Reports > Trade Confirmations > Reports.

If you have a multiple account structure such as an institution account or multiple linked

accounts, use the Account Selector at the top of the page to select an account on which to

report. To generate a Trade Confirmation report for a closed account, select the Include

Closed Accounts check box, and then select the closed account.

The Account Selector is closed once you select an account. To change the selected

account, click the tab to open the Account Selector, and then click a different account.

2. Make the following selections:

o In the Date fields, select the dates for the report.
o In the Format field, select HTML/WEB or PDF.
o In the Language list, select your desired language.

Advisors, Money Managers and Brokers and master account users with reporting access

rights who select their own master account in the Account Selector have access to client-

only consolidated and concatenated reports. Select Consolidated (Clients-Only) to
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generate trade confirmations for all clients combined into a single report, or Concatenate

All (Clients-Only) to generate statements for all client accounts in a single report (multiple

client reports are joined together in a single report).

3. Click View to generate the report.

If you selected PDF as the Format, you will be prompted to open the generated report or

save it to your computer.

Summary rows are marked with a plus sign. Click a summary row to display detail rows;

click the summary row again to close the detail rows.

Trade Allocations

The Trade Allocation Report provides pre-trade and post-trade allocation details. Post-trade

allocations should be available by 6:15 PM Eastern time for the current trading day.
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Who can access the Trade Allocations page?

You can access this page if you are a Proprietary Trading Group Master or Sub Account and

subscribe to our IBExecution Service.

To run the Trade Allocations report

1. Click Reports > Trade Confirmations > Trade Allocations.

2. On the Trade Confirmations screen, make the following selections:

o In the Account ID list, select the account for which you want to generate the report.

If you are a Master User, the Account list will not appear. Instead, use the Account

Selector to select an account. The most recent account you selected is the current

account when you come to this page.You can switch accounts after you select an account

by clicking the Account Selector tab, then selecting a different account.

o In the From and To Date fields, select the dates for the report.
o To filter the report by a specific broker name, select a broker name in the Broker Name

field. Select All to include all broker names in the report.
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o To filter the report by a specific broker account, select All in the Broker Name field and

select a specific broker account in the Broker Account field. Select All to include all

broker accounts in the report.

3. Click View to generate the report.

Trade Confirmation Flex Queries

The Trade Confirms Flex page lets you create multiple, customized report templates for trade

confirmations. A trade confirmation Flex Query lets you specify the exact fields you want to view

in your report, the time period you want the report to cover, the order in which you want the

fields to appear in the report, and the display format for the report.

You can create multiple Flex Queries with different fields for each query. All of your Flex queries

are stored in Account Management. You can also add a default Flex Query, then use it as the

basis for your own by editing it.

The Flex Queries page lets you create a new flex query or edit an existing Flex Query. Existing

Flex Queries are displayed in the Saved Flex Queries section of the page. You can also edit the

default Flex Query to use it as the basis for your own Flex Query.

Saved Flex Queries are available for the four previous calendar years and from the start of the

current calendar year.

Who can access the Trade Confirmation Flex Queries page?

You can access this page if you are a(n):

Individual, Joint, Trust or IRA Account User

Small Business Account User

Friends and Family Group Master or Client User

Advisor Master User Individual

Advisor Master User Organization

Advisor Client User Individual

Advisor Client User Organization
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Proprietary Trading Group Master User

Proprietary Trading Group Sub User

Broker Master User (master account only)

Broker Fully Disclosed Client User

Broker Fully Disclosed Client User Organization

Investment Manager Master User

Fund

and you have been granted Reporting access rights.
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To create a trade confirmation flex query

1. Click Reports > Trade Confirmations > Flex Queries.

2. Do any of the following:

o To create a new query, click Create New Flex Query.
o To run an existing query, click Run for the query.
o To edit an existing query, click Edit for the query, then make your changes to the query

and click Save Query.
o To delete an existing query, click Delete.
o To add the Default Trade Confirmation Flex Query, click Create Default Flex Query.

Note that when you add a default query to the list, the button disappears from the page.

If you delete a default query from the list, the button re-appears.
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3. If you clicked Create New Flex Query, a new page appears on which you create your

new Flex Query.

If you have a multiple account structure such as an institution account or multiple linked

accounts, use the Account Selector at the top of the page to select one or more accounts

on which to report. To include accounts that you have recently closed, select the Include

Closed Accounts check box. If you choose to include closed accounts, those accounts

appear in the Account Selector.

4. Make selections and set options in the Configuration sections as follows:
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o In the Query Name field, enter the name of the flex query.
o In the Output Format list, select Text or XML. If you select Text, you must also choose a

delimiting character (comma, pipe or tab character), and optionally choose to include

header and trailer records; column headers; and section code and line descriptors.
o Select other options as required. Note that the Consolidated and All options are only

available when the master account has been selected in the Account Selector.
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o In the Date Configuration section, select the period for the Flex Query, or enter a range

of dates in the From Date and To Date fields. The following periods are available:

Today

Last Business Day

Last Month

Last 30 Calendar Days

Last 365 Calendar Days

Month to Date

Year to Date

Last Business Week (Mon-Fri)

Last N Calendar Days (when you select this option, you must then select a number

from 1 to 365 from a drop-down)
o In the Date Configuration section, select a Date Format, Time Format and Date/Time

Separator:

Available date formats are:

yyyyMMdd (default)

yyyy-MM-dd

MM/dd/yyyy

MM/dd/yy

dd/MM/yyyy

dd/MM/yy

dd-MMM-yy

Available time formats are:

HHmmss (default)

HH:mm:ss

Available date/time separators are:

; (semi-colon, the default)

, (comma)

'' (single-spaced)

No separator
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o Advisors, Money Managers and Brokers and master account users with reporting

access rights who select their own master account in the Account Selector have access

to client-only consolidated and concatenated reports. Select Consolidated (Clients-

Only) to generate trade confirmations for all clients combined into a single report, or

Concatenate All (Clients-Only) to generate statements for all client accounts in a

single report (multiple client reports are joined together in a single report).

5. In the Trade Confirmation Configuration section, Select the fields to include in the Flex

Query in by highlighting the fields in the Fields Available list, then using the green right

arrow to move the fields to the Fields Included list. Use the green left arrow to move fields

from the Fields Included list (and exclude the fields from the report).

6. In the Trade Confirmation Configuration section, select your desired level of detail: Sym-

bol Summary,Order or Execution. Execution is the default setting.

7. Click Save Query.

The saved query will now appear in the list of saved queries on the Trade Confirmation

Flex Queries page.

For more information

User's Guide

PortfolioAnalyst
PortfolioAnalyst allows you to evaluate the performance of your portfolio by creating and saving

reports based on a set of measurement criteria and optionally comparing their data to selected

industry benchmarks. Once you create and save reports, you can run, edit or delete them.

Institutional account Master users (Advisor Masters, Broker Masters, Fund Investment

Managers and Proprietary Trading Group Masters) can also create and save synopses, which

are text-based cover letters that you can assign to PortfolioAnalyst reports.

PortfolioAnalyst lets you:
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Create Detailed Reports - Select any combination of reports for a variety of performance ana-

lysis. Save your reports in PDF or comma-separated values (CSV) format.

Create Snapshot PDF reports - One-page summaries of an account's return, NAV, asset

allocation and distribution of returns.

View your portfolios of external investment accounts

You can also create your own custom benchmarks and select them when creating a Snapshot

or Detailed report.

Who can access the PortfolioAnalyst page?

You can access this page if you are a(n):

Individual, Joint, Trust or IRA Account User

Small Business Account User

Friends and Family Group Master or Client User

Advisor Master User Individual

Advisor Master User Organization

Advisor Client User Individual

Advisor Client User Organization

Proprietary Trading Group Master User

Proprietary Trading Group Sub User

Broker Master User (master account only)

Broker Fully Disclosed Client User

Broker Fully Disclosed Client User Organization

Broker Non-Disclosed Client User

Investment Manager Master User

Fund

and you have been granted Reporting access rights.

Here is the PortfolioAnalyst main page:
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PortfolioAnalyst currently includes the ability to view your portfolios and positions held at other

institutions.

Institution accounts willl see an extra tabbed page for creating and managing synopses).
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Snapshot PDF Reports

The Snapshot is a one-page report that displays graphs and charts representing an account's

return, Net Asset Value (NAV), asset allocation and distribution of returns. The Snapshot gives

you a downloadable and printable summary of an account’s performance and is suitable for

presentation to advisor and broker clients. Optionally, you can include a benchmark comparison

to compare your own performance against an industry standard benchmark or your own custom

benchmark.

To create and run a Snapshot PDF report in PortfolioAnalyst

1. Click Reports > PortfolioAnalyst.

PortfolioAnalyst includes default Snapshot PDF reports. These are displayed on the

Default Reports tab, which appears when you first open PortfolioAnalyst. Run these

reports or any other in the list by clicking the PDF icon in the Snapshot column of the

Default Reports tab.

2. Click the Custom Reports tab. This tab lists all of your previously created and saved cus-

tom PortfolioAnalyst reports.
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3. Click CREATE REPORT.
4. If you are a Master account user responsible for client or sub accounts or you have mul-

tiple linked accounts, select one or more accounts in the Account Selector.

The report settings appear.

5. Type the name of the new report in the Name field.

6. If you are a Master account user, the Assign Synopsis button appears. Optionally, assign

previously created synopses to the PortfolioAnalyst report:
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o Click Assign Synopsis.
o In the Assign Synopsis dialog, select a previously-saved synopsis, select the accounts

whose reports to which you want to attach the synopsis, then click Assign. Click Apply

to apply your selections.

7. Select a time period:

o Select Daily,Monthly,Quarterly, Previous Month, Previous Quarter,Month To

Date, Year To Date or Since Inception (since the inception of your account), depend-

ing on how you want to view the data.
o If you selected a daily time period, select a starting and ending date (up to a maximum

of 60 days) using the calendar popoup. If you selected a monthly time period, select a

starting and ending month. If you selected a quarterly time period, select a starting and

ending quarter. Click the icons next to the Starting Period and Ending Period fields to

pick dates from a calendar.

Analysis results include data available from January 2008 to the present.

8. For Performance Measure, select Time Weighted Return orMoney-Weighted Return.

o Time-Weighted Return (TWR):Select this metric to view the percent return produced

over time independent of contributions or withdrawals. TWR eliminates the impact of

the timing of fund cash flows and isolates the portion of a portfolio's return that is attrib-

utable solely to the manager's actions. TWR is typically used for public fund managers

because they normally do not control cash flowing into or out of their funds.
o Money-Weighted Return (MWR): Select this metric to view the performance of your

portfolio during the specified report period. MWR is calculated using the Modified Deitz

method and is influenced by the time of decisions to contribute or withdraw funds, as

well as the decisions made by the portfolio manager of a fund.
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9. Select Snapshot as the Report Type.
10. Choose how you want your account number to appear on your report in the Account Num-

ber Display section:

o Use Account Number: Select this option to include your Account ID on your report.
o Use Account Alias: Select this option to include your Account Alias on your report if

you want to hide the actual Account ID.

11. If you are an Advisor, Money Manager, Broker, Proprietary Trading Group STL Account

Master or you have multiple linked accounts and you have selected multiple accounts in

the Account Selector, you have the option of created a consolidated Snapshot report for

all of the selected accounts.

o Click the Consolidate check box to create create a consolidated Snapshot report,

which includes a single set of data from all of the accounts that you have selected.
o If you select only one account in the Account Selector, click the Consolidate All check

box to create a consolidated report which includes a single set of data from all

accounts.

12. Optionally, you can include a benchmark comparison in your Snapshot report. When you

select the Snapshot radio button, the Select Benchmarks section appears.

Select up to three benchmarks from the list of Available benchmarks (including your own

custom benchmarks) then click the right arrow button to move them into the Selected list.

Select one or more benchmarks using the Ctrl+click keyboard combination. Move

benchmarks out of the Selected list by selecting them then clicking the left arrow button.

Account Management Users' Guide 123



13. Click SAVE to save the report. Once you save a report, it will appear in the list of saved

PDF reports.

14. Click CANCEL to cancel the report.
15. View the report by clicking the Run icon in the list of saved reports. Your report appears in

a new window.

If there is a negative Net Asset Value during the time period you select for your Snapshot

report, the report will not be generated.

The Snapshot includes the following sections:

Account Information: Displays your account name and number, account alias if you have

one, your base currency, account type and the specified time period.

Return Over Time: Displays a line chart showing the account's return percentage over the

specified time period.

Net Asset Value: Displays a bar chart showing the account's Net Asset Value over the spe-

cified time period.

Distribution of Returns: Displays a bar chart showing the range of return percentage for

each day, month or quarter in the specified time period and the number of times the return

performance fell within that range for the entire period.

Key Statistics: Displays several statistics for the specified time period, including beginning

and ending NAV, return percentages (depending on your selected time period), the best

return and the worst return.

Asset Allocation: Displays two pie charts, one representing the account's asset allocation

at the beginning of the specified time period and one representing the account's asset alloc-

ation at the end of the specified time period.

The following example shows a typical Snapshot report.
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Detailed PDF Reports

Detailed PDF reports let you select any combination of reports, including benchmark

comparisons, for a variety of performance analysis. You can also create your own custom

benchmarks.

To create and run a Detailed report in PortfolioAnalyst
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1. Click Reports > PortfolioAnalyst.

PortfolioAnalyst includes default PDF and CSV-formatted Detailed reports. These are

displayed on the Default Reports tab, which appears when you first open PortfolioAnalyst.

Run these reports or any other in the list by clicking the PDF or CSV icons in the Detailed

column of the Default Reports tab.

2. Click the Custom Reports tab. This tab lists all of your previously created and saved cus-

tom PortfolioAnalyst reports.
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3. Click Create Report.

4. If you are a Master account user responsible for client or sub accounts or you have mul-

tiple linked accounts, select one or more accounts in the Account Selector.

The report settings appear.

5. Type the name of the new report in the Name field.

6. If you are a Master account user, the Assign Synopsis button appears. Optionally, assign

previously created synopses to the PortfolioAnalyst report:

o Click Assign Synopsis.
o In the Assign Synopsis dialog, select a previously-saved synopsis, select the accounts

whose reports to which you want to attach the synopsis, then click Assign. Click Apply

to apply your selections.
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7. Select a time period:

o Select Daily,Monthly,Quarterly, Previous Month, Previous Quarter,Month To

Date, Year To Date or Since Inception (since the inception of your account),

depending on how you want to view the data.
o If you selected a daily time period, select a starting and ending date (up to a max-

imum of 60 days) using the calendar popup. If you selected a monthly time period,

select a starting and ending month. If you selected a quarterly time period, select a

starting and ending quarter. Click the icons next to the Starting Period and Ending

Period fields to pick dates from a calendar.

Analysis results include data available from January 2009 to the present.

8. Select Detailed as the Report Type.
9. Select the output format for the report (CSV or PDF).
10. For Performance Measure, Time-Weighted Return (TWR) is already selected for you,

select Time Weighted Return orMoney-Weighted Return.

o Money-Weighted Return (MWR): Select this metric to view the performance of your

portfolio during the specified report period. MWR is calculated using the Modified Deitz

method and is influenced by the time of decisions to contribute or withdraw funds, as

well as the decisions made by the portfolio manager of a fund.
o Time-Weighted Return (TWR): Select this metric to view the percent return produced

over time independent of contributions or withdrawals. TWR eliminates the impact of
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the timing of fund cash flows and isolates the portion of a portfolio's return that is attrib-

utable solely to the manager's actions. TWR is typically used for public fund managers

because they normally do not control cash flowing into or out of their funds.

11. Choose how you want your account number to appear on your report:

o Use Account Number: Select this option to include your Account ID on your report.
o Use Account Alias: Select this option to include your Account Alias on your report if

you want to hide the actual Account ID.

12. Optionally, you can include cover page and table of contents with your Detailed

PDF report by checking the appropriate Optional Pages check boxes.

13. If you are an Advisor, Money Manager, Broker, Proprietary Trading Group STL Account

Master or you have multiple linked accounts and you have selected multiple accounts in

the Account Selector, you have the option of created a consolidated Snapshot report for

all of the selected accounts.

o Click the Consolidate check box to create create a consolidated Detailed report, which

includes a single set of data from all of the accounts that you have selected.
o If you select only one account in the Account Selector, click the Consolidate All check

box to create a consolidated report which includes a single set of data from all

accounts.

If you have selected the Consolidate or Consolidate All check box, you can select the

Breakdown of Accounts report, which provides key account values for the accounts that

you have chosen to consolidate.

14. Detailed PDF reports can contain the following distinct reports for each selected account.

Click the check box to include a report. Note that this section is not available in Snapshot

reports.
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See Available Reports in Detailed PDF Reports for descriptions of these reports.

15. If you select any of the benchmark reports, the Select Benchmarks section appears.

Select up to three benchmarks from the list of Available benchmarks (including your own

custom benchmarks) then click the right arrow button to move them into the Selected list.

Select one or more benchmarks using the Ctrl+click keyboard combination. Move

benchmarks out of the Selected list by selecting them then clicking the left arrow button.

The same set of benchmarks will apply to all the benchmark reports that you select.

16. Click Save to save the report. Once you save a report, it will appear in the list of saved

reports.

17. View the report by clicking the Run icon in the list of saved reports. Your report appears in

a new window. For CSV-formatted reports, you will be prompted to save the report to your

computer, where you can open the file in a program like Microsoft Excel.
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If there is a negative Net Asset Value during the time period you select for your Detailed

report, the report will not be generated.

Available Reports in Detailed PDF Reports

When create a Detailed PDF Report, you can select any of the following reports to include in

the final PDF report:

Report Description

Breakdown of Accounts Available only to institution accounts andmultiple linked accounts

who have selectedmultiple accounts and theConsolidate option,

this report shows the Beginning and Ending NAV, Return, and the

total amounts of Deposits, Withdrawals, Dividends, Interest and

Fees for each selected account.

Account Overview Displays general settings, including account name and number,

account alias, base currency and the specified time period. It also

displays the performance of your portfolio for the specified time

period, including beginning and ending Net Asset Value (NAV) and

return percentage based on your selected time period and

performancemeasurement (TWR orMWR).

A color-coded bar chart plots NAV over time, and a color-coded line

chart shows the return percentage (TWR orMWR) over the same

time scale. Additional performance statistics are also included in the

Overview section.

Open Position Summary Shows all current open positions in the selected account(s). The

report output shows two pie charts: the five long open positions that

have the highest market value, and the five short positions with the

highest market value.

The output also displays a table of all open positions sorted by

product, then currency, then symbol. The table includes the quantity,

closing price, current market value and the percent of your total Net

Asset Value for that position.

If you select this report but there are no open positions during the
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specified time period, the report will be omitted from your results.

Allocation by Asset Class Displays a color-coded bar chart and table that illustrates the NAV of

all assets in your portfolio for each day, month or quarter in the

specified time period.

If you select this report but there are no open positions during the

specified time period, the report will be omitted from your results.

Allocation by Sector Displays a color-coded bar chart and table that illustrates the NAV of

stocks and options in your portfolio by sector for each day, month or

quarter in the specified time period.

If you select this report but there are no open positions during the

specified period, the report will be omitted from your results.

Allocation by Region Displays color-coded pie charts and accompanying tables. One pair

of pie charts shows the percentage and amount of the portfolio’s long

and short positions allocated to assets in those regions. The second

pair of pie charts shows the countries with the highest percentage

and amount of long and short position allocation to assets (Weight

%). The tables display the same data. If there aremore than five

countries to which positions are allocated, the additional countries

appear in the Other category.

Time Period Performance Stat-

istics

Shows the performance of your portfolio for a specified time period as

a line chart and a text summary. The line chart plots the return

percentage for the selected performancemeasure (TWR orMWR)

over time. The text summary includes the beginning and ending NAV,

the return percentage (TWR orMWR) for the time period, the one-

and three-month return percentage (the three-month return only

appears if the time period is at least six months), and the best and

worst return percentage of the period.

Reports with amonthly time period display one- and three-month

returns. Reports with a daily time period display five- and ten-day

returns. Reports with a quarterly time period display one- and two-

quarter returns. The line chart and text summary are identical to those

Account Management Users' Guide 132

Chapter 3 Available Reports in Detailed PDF Reports



Chapter 3 Available Reports in Detailed PDF Reports

Report Description

in the Account Overview report.

Time Period Benchmark Com-

parison

Select up to three global industry benchmarks against which you

want to compare your performance results over a specified time

period. The report output displays a color-coded line chart comparing

the return percentage (TWR orMWR) of your portfolio over time with

that of the selected benchmarks. The line chart plots the return

percentage for each day, month or quarter over the specified time

period, and also displays the average return percentage for the entire

time period.

Returns for ETFs and indices selected as benchmarks include

dividends.

Cumulative Performance Stat-

istics

Shows the cumulative performance of your portfolio over a specified

time period as a line chart and a text summary. The line chart plots

the return percentage for the selected performancemeasure (TWR or

MWR) over time. The text summary includes the beginning and

ending NAV, the return percentage (TWR orMWR) for the time

period, the one- and three-month return percentage (the three-month

return only appears if the time period is at least six months), and the

best and worst return percentage of the period.

Reports with amonthly time period display one- and three-month

returns. Reports with a daily time period display five- and ten-day

returns. Reports with a quarterly time period display one- and two-

quarter returns. The line chart and text summary are identical to those

in the Account Overview report.

Cumulative Benchmark Com-

parison

Select up to three global industry benchmarks against which you

want to compare cumulative performance results over a specified

time period.

The report output displays a color-coded line chart comparing the

cumulative return percentage (TWR orMWR) of your portfolio over

time with that of the selected benchmarks. The line chart plots the

cumulative return percentage over the specified time period,
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aggregating the return percentage for each successive day, month or

quarter in the time period.

Returns for ETFs and indices selected as benchmarks include

dividends.

Risk Measures Shows the current risk of your portfolio in a line chart and text

summary. The line chart plots Value-AddedMonthly Index (VAMI)

over the specified time period. VAMI is an index that tracks the

monthly performance of your portfolio based on a hypothetical initial

$1000 investment.

The text summary shows a variety of risk measures, includingMax

Drawdown, Peak-to-Valley Drawdown, Recover, Sharpe Ratio,

Sortino Ratio, Calmar Ratio, Standard Deviation, Downside

Deviation, Mean Return, Positive Periods and Negative Periods.

In addition, this report includes a Distribution of Returns bar chart

showing the range of return percentage for each day, month or quarter

in the specified time period and the number of times the return

performance fell within that range for the entire period.

Risk Measures Benchmark Com-

parison

Select up to three global industry benchmarks against which you

want to compare the current risk of your portfolio in a line chart and

text summary.

The line chart plots Value-AddedMonthly Index (VAMI) over the

specified time period for your portfolio and for your selected

benchmarks. VAMI is an index that tracks themonthly performance

of your portfolio based on a hypothetical initial $1000 investment.

The text summary shows a variety of risk measures for your portfolio

and for your selected benchmarks, includingMax Drawdown, Peak-

to-Valley Drawdown, Recover, Sharpe Ratio, Sortino Ratio, Calmar

Ratio, Standard Deviation, Downside Deviation, Mean Return,

Positive Periods and Negative Periods.

In addition, this report includes a Distribution of Returns bar chart

showing the range of return percentage for each day, month or quarter
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Report Description

in the specified time period and the number of times the return

performance fell within that range for the entire period.

Returns for ETFs and indices selected as benchmarks include

dividends.

Performance Attribution Shows how your asset allocation and selection of securities affects

your portfolio’s performance when compared to the performance of

the S&P 500 Index over a specified time period.

This report includes a summary table that shows how you

outperformed or underperformed the S&P 500, as well as two charts

and a scatter plot. For more information about this report, see

Running a Performance Attribution Report.

Performance by Asset Class Displays a color-coded bar chart that illustrates the cumulative con-

tribution to your portfolio's return by asset class for each day, month

or quarter in the specified time period. Each color-coded bar in the

chart represents the contribution of all asset classes to each day/-

month/quarter in the specified time period .The table shows the return

for each asset class for each day/month/quarter in the specified time

period.

Performance by Sector Displays a color-coded bar chart and table that illustrate the con-

tribution to your portfolio's return by sector for each day, month or

quarter in the specified time period. The bars in the bar chart are color-

coded by sector. The table shows the values depicted in the chart.

Performance by Symbol Displays four charts, a table and two heat maps representing the

performance of the symbols in your portfolio:

Top Five Contributors - This chart displays the five symbols with

the highest contribution to your portfolio's return.

Bottom Five Contributors - This chart displays the five symbols

with the lowest contribution to your portfolio's return.

Contribution by Sector - This bar chart displays the contribution of

each sector to your portfolio's return.

Contribution by Asset Class - This bar chart displays each the

Account Management Users' Guide 135



Report Description

contribution of each asset class to your portfolio's return.

Table - Shows data for all open or closed symbols grouped by

asset class, including sector, AverageWeight, Return, Con-

tribution to Return, and Unrealized and Realized P&L in dollar

amounts.

Sector Composition Heat Map - This is a visual representation of

each sector's contribution to return. Each sector block shows the

contribution to return of each symbol in that sector. The larger the

block, the larger the contribution to return.

Portfolio Heat Map - This is a visual representation of the con-

tribution to return of each symbol in your portfolio. Green indicates

a positive return while red indicates a negative return.

Historical Performance Shows the history of your portfolio's performance in a variety of

charts and tables on three pages:

The first page of the report includes two charts, a History bar

chart that shows the cumulative return percentage at different

points in time in the history of your account (MTD, QTD, YTD, 1

year, 3 year, 5 year and since inception), a table that displays the

same data as the History chart, and a line chart that shows the

cumulative return percentages since the inception of your

account.

The second page of the report includes two tables. One table dis-

plays themonthly returns of your account for the past five years

(or since the inception of your account if it is less than five years

old). The second table shows the quarterly returns of your

account for the last five years (or since the inception of your

account if it is less than five years old).

The third page of the report includes a bar chart and a table. The

bar chart displays the return percentage of your portfolio for the

year-to-date and for each of the last five years, or fewer years if

your account has been open for less than five years. The table dis-

plays the data from the chart.
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Report Description

This report will only include 1 Year, 3 Year, 5 Year, Yearly, Quarterly

andMonthly returns if there is data available for the account for the

full period.

Historical Performance Bench-

mark Comparison

Select up to three global industry benchmarks against which you

want to compare the history of your portfolio's performance. This

report includes the same charts and tables as the Historical

Performance Report described above.

Returns for ETFs and indices selected as benchmarks include

dividends.

This report will only include 1 Year, 3 Year, 5 Year, Yearly, Quarterly

andMonthly returns if there is data available for the

account/benchmark for the full period.

Trade Summary Shows information for all trades made in the selected time period,

grouped by asset type and then by currency. Information includes

symbol; description; sector; and quantity, average price and pro-

ceeds from buys and sells.

Deposits andWithdrawals Shows the inbound and outbound cash and position transfers (includ-

ing cash deposit and withdrawals) in your account for a specified time

period. This report displays a table that includes the date, type,

description and amount of each inbound and outbound cash and pos-

ition transfer in the time period of the report.

Dividends The Dividends report shows all dividends that occurred in your

account during a specified time period, including dividend payments,

dividend cancellations, payments in lieu, short term and long term

capital gains. The report includes a table and a bar chart. Each line

item in the table includes the pay date, ex-date, symbol, note,

quantity, dividend per share, estimated forward dividend yield%,

estimated annual dividend and amount during the specified time

period.

The report also includes a color coded stacked bar chart illustrating

the distributions of dividends during the time period.
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Report Description

Interest Details Lists all interest that occurred in your account during the specified

time period. Each line item in the table includes the date, description

and amount.

Corporate Actions Lists all corporate actions that occurred in your account during the

specified time period. Each line item includes the date, type, descrip-

tion and quantity. If you select this report and you have no corporate

actions in the specified time period, this report will not appear in your

Detailed Report.

Fee Summary Lists all fees that were charged to your account in the specified time

period. Each line item includes the date, description and amount of

the fee. The amounts are totaled at the bottom of the list.

Running a Performance Attribution Report

The Performance Attribution Report helps you determine how your asset allocation and

selection of securities affects your portfolio’s performance when compared to the performance

of the S&P 500 Index.

To run a Detailed PDF Report with the Performance Attribution Report, set up your Detailed

PDF Report as you normally would, and select Performance Attribution in the Select Report(s)

section of the page.

Understanding the Performance Attribution Report Table

The first part of the Performance Attribution Report contains two tables:

Weighting by Sector

Returns and Attribution Effects by Sector

Weighting by Sector

This table shows how your portfolio is allocated among ten different sectors, cash and

unclassified (anything not included in one of the other sectors), and how that allocation
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compares to the S&P 500 Index. The table has three parts: Beginning Weight, Ending Weight

and Average Weight.

These tables show the beginning, ending and average weight for each sector in your portfolio

and the S&P 500, and the difference (positive or negative) between the two, represented by a

percentage. You can use this table to see how under or overweighted your portfolio is in each

sector compared to the S&P 500.

Returns and Attribution Effects by Sector

This table lets you compare your returns in each of the ten sectors, plus cash and unclassified,

to those of the S&P 500, and view the attribution effects of your sector allocation and stock

selection within each sector. Attribution effects let you see why your returns in a particular

sector were better or worse than those of the S&P 500.

The Period Return part of the table shows the absolute return percentage for each sector in your

portfolio and for the S&P 500, and the difference (positive or negative) between the two.

The Contribution to Return part of the table measures the contribution of each sector to the

overall return. The table also illustrates the contribution of return for the account of each sector

versus the S&P 500. The standard calculation used to derive the Contribution to Return is:

Period Return x Beginning Weight = Contribution to Return

The attribution effect part of the table shows the attribution effects of sector allocation (Allocation

column), the attribution effects of security selection within each sector (Selection column), and

the total attribution effects for the period of the report. The attribution effect dissects the return

and illustrates the reason for your outperformance or underperformance.

The allocation effect determines whether the overweighting or underweighting of sectors

relative to a benchmark contributes positively or negatively to the the account’s return. Positive

allocation occurs when the portfolio is overweighted in a sector that outperforms the benchmark,

and underweighted in a sector that underperforms the benchmark.
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The selection effect measures the account’s ability to select securities within a sector relative to

the benchmark. A positive selection will occur if the account made better stock selections within

the sector compared to the benchmark.

Understanding the Performance Attribution Charts

The second page of the Performance Attribution Report shows two charts:

Cumulative Attribution Effect - This line chart that plots return percentage over time and cov-

ers the entire time period of the report.

Attribution Effect - This chart that shows the allocation, selection and total attribution effect

percentages for each period in the report.

Understanding the Performance Attribution Scatter Plot

The third page of the Performance Attribution Report displays a scatter plot that shows average

weight versus percent contribution return for each sector plus cash and unclassified. The scatter

plots lets you see at a glance how your weighting (sector allocation) and contribution to return

for each sector compares to the S&P 500 for the period of the return.

There are four quadrants in the scatter plot; each sector is represented somewhere in the four

quadrants based on its average weight and contribution to return (both values are taken from

the tables on the first page of this report).

The following illustration shows how to interpret the scatter plot results; depending on the

quadrant in which each sector appears, its average weight percent and contribution to return

percent either under- or overperformed the S&P 500 for the period of the report.

Account Management Users' Guide 140

Chapter 3 Understanding the Performance Attribution Charts



Chapter 3 Creating Custom Benchmarks

Creating Custom Benchmarks

While PortfolioAnalyst provides a large number of standard industry benchmarks for you to

choose in a Snapshot or Detailed Report against which your portfolio's performance can be

compared, there may be situations when a standard benchmark does not provide and adequate

basis for comparison. In these situations, you can create your own custom benchmarks in

PortfolioAnalyst.

About Custom Benchmarks

Custom benchmarks allow you to combine existing benchmarks already available in

PortfolioAnalyst, the combined weight of which must equal 100%. When you select benchmarks

for a specific benchmark comparison report, you can choose up to three existing benchmarks

including any of your own custom benchmarks.

The return formula for a custom benchmark is calculated as:

Σ(Benchmark Weight X Benchmark Return)

Here is an example of a custom benchmark. In this example, a custom benchmark has been

created by combining three existing standard benchmarks:

Index Weight Return

Russell 2000 40% 20.00%
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Index Weight Return

S&P 500 40% 10.00%

S&P US High Yield Corporate Bond 20% 6.00%

Based on the weights and returns of each component benchmark, the return for this custom

benchmark is 13.20%, calculated as:

(.40 x .20) + (.40 x .10) + (.20 x .06) = 13.20%

Observe the following guidelines when creating custom benchmarks:

You cannot use an existing custom benchmark as part of a new custom benchmark. Only

the standard benchmarks can be used when creating a custom benchmark.

You must include at least two standard benchmarks when creating a custom benchmark.

You can add any number of standard benchmarks to a custom benchmarks, as long as the

total weight equals 100%.

Each standard benchmark included in a custom benchmark must have a weight between 0

and 100. No standard benchmark in a custom benchmark can have a weight of either 0 or

100.

You can add multiple standard benchmarks at a time to a custom benchmark.

To create a custom benchmark

1. Click Reports > PortfolioAnalyst.
2. Click the Custom Benchmarks tab. The Custom Benchmarks tab lists all of your saved

custom benchmarks. If you have not saved any custom benchmarks, the list will be empty.

For example, the abbreviation for the S&P 500 Index is SPX.
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3. Click Create Custom Benchmark.

4. Type the name of the custom benchmark in the Name field, and type an abbreviation in

the Abbreviation field.

5. In the list of available benchmarks, select the first benchmark you would like to include,

and then click Add Benchmark. You can type the first few characters of the desired

benchmark in the entry box above the list of benchmarks or type the abbreviation of the

desired benchmark. Note that you can select multiple standard benchmarks at a time and

add them all at once to your custom benchmark.

The benchmark is added to the Selected list.

6. Continue selecting and add benchmarks to your custom benchmark as required. Click the

Xto delete a benchmark from the list of selected benchmarks.

7. When you have finished adding benchmarks, enter the weight of each benchmark in the

field provided. All benchmark weights must equal 100.
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8. Click Save to save your custom benchmark. It will now be listed on the Custom Bench-

marks tab, where you can edit or delete it.

9. When you select benchmarks for a Detailed report, you will be able to select your custom

benchmark. Custom benchmarks are always listed first in the list of benchmarks.

Synopses

Institutional account Master users (Advisor Masters, Broker Masters, Fund Investment

Managers and Proprietary Trading Group Masters) can create and save synopses, which are

text-based cover letters, and then assign them to PortfolioAnalyst reports.

Creating and Saving a Synopsis

You can create, save, edit or delete a synopsis from within PortfolioAnalyst.

To create and save a synopsis

1. Click Reports > PortfolioAnalyst.
2. Click CREATE REPORT or click the edit icon for any saved report.
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3. Click the Synopses tab. The Manage Synopses tab displays all of your previously saved

synopses. From this tabbed page, you can view or edit an existing synopsis, delete a syn-

opsis or create a new synopsis.

4. Click CREATE SYNOPSIS.

5. Enter the name of the synopsis in the Title field.

6. Type the text of the synopsis in the Text area up to a maximum of 3000 characters.

7. Click SAVE. Click CANCEL to cancel the operation.

You will now be able to assign this synopsis to a PortfolioAnalyst report.
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Assigning a Synopsis to a Report

When you are creating a new PortfolioAnalyst report or editing an existing report AND you have

selected multiple client, sub or linked accounts in the Account Selector, you can attach a

synopsis (cover letter) to the report.

To assign a synopsis to a report

1. Click Reports > PortfolioAnalyst.
2. Click CREATE REPORT or click the edit icon for any saved report.
3. If you are a Master account user responsible for client or sub accounts or you have mul-

tiple linked accounts, select one or more accounts in the Account Selector.

4. Enter or edit the report settings as required.

5. Click Assign Synopsis.
6. In the Assign Synopsis dialog, select a previously-saved synopsis, select the accounts

whose reports to which you want to attach the synopsis, then click Assign.

7. Click Apply to apply your selections to the report.
8. Finish entering or editing the PortfolioAnalyst report settings as required, then save the

report.

Editing and Deleting Saved PortfolioAnalyst Reports

To delete a saved report
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1. Click Reports > PortfolioAnalyst.
2. Click the Custom Reports tab.

3. Click the Delete icon in the list of saved reports to delete the report.

To edit a saved report

1. Click Reports > PortfolioAnalyst.

2. Click the Custom Reports tab.
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3. Click the Edit icon in the list of saved reports, then modify the report as required.
4. Click SAVE when you are done editing the report.

Viewing External Accounts

PortfolioAnalyst lets you view accounts held at financial institutions, including investment and

non-investment accounts, other than Interactive Brokers at a glance, and drill down to see the

value of the positions.

To do this, you use the following two tabbed pages in PortfolioAnalyst:

Summary - View the prior value, current value, percent change in value and returns for your

IB and external accounts, and drill down to view the value of individual positions.

External Accounts - Add, view, edit and delete investment accounts from financial insti-

tutions other than Interactive Brokers.

External accounts are currently NOT available to Advisor and Broker Masters, Money Managers

and Non-disclosed Broker clients.

Account Management Users' Guide 148

Chapter 3 Viewing External Accounts



Chapter 3 Account Summaries

Account Summaries

The PortfolioAnalyst Summary tab lets you:

View the current and prior values and returns for your IB and external accounts. View a con-

solidated summary of all accounts or view a summary for each financial institution.

Drill down to view the current and prior values of each position in each asset class. View a

consolidated summary of all positions for all accounts or view specific positions for each fin-

ancial institution.

Drill down to view transactions for any symbol.

To use the Summary tab

1. Click Reports > PortfolioAnalyst.
2. Click the Summary tab.

By default, the Summary tab displays the categories in which you have added external

accounts (Banking, Credit Cards, Investment, etc.), along with prior and current values for

all of your accounts in each category. This is the Consolidated view.
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If you have not added any external accounts, the Summary page will show your account

(s) held here by default.

3. Click a category to view all financial institutions that you have added.

4. Select the current time period from the Time Period drop-down:

o Daily
o Month to Date
o Year to Date
o Custom Period - When you select this option, you must also enter a starting and ending

date.

The values and percent change in value will reflect your time period selection.

5. Change the view in the View By drop-down (by default, the view shows financial insti-

tutions):

o Consolidated - Displays prior and current values and percent change for all asset

classes in all accounts.
o Financial Institution - Displays prior and current values and percent change for each fin-

ancial institution. Click the down arrow next to a financial institution to display all of the

accounts that you have under for that institution.
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If you have multiple accounts for a financial institution, you can click the name of the

institution to expand the view to include all accounts.

6. You can drill down to view positions in both the Consolidated and Financial Institution

views:

o In Financial Institution view, click the individual account to display the asset classes in

that account.

o Then click an asset class to drill down to the individual positions. Click a link in the

breadcrumb display to quickly go back to a previous view. You can also change the

Time Period.
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o In Consolidated view, click an asset class to view all of the positions in that asset class

for all of your accounts. Click a link in the breadcrumb display to quickly go back to a

previous view. You can also change the Time Period.

External Accounts

The PortfolioAnalyst External Accounts tab lets you:

Add external investment accounts;

View and edit external investment accounts that you have already added;

Delete external investment accounts from PortfolioAnalyst.
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Adding an External Account

To add an external investment account to PortfolioAnalyst

1. Click Reports > PortfolioAnalyst.
2. Click the External Accounts tab.

3. Click Add Accounts.
4. A disclaimer opens in a popup window. Read the disclaimer and then click Yes to close

the window.

5. Select the financial institution from the list.
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You can type the name of financial institution where the external account is maintained in the

search field. This is a smart search field; once you start typing the name of the institution,

matching institutions appear in the list below the field.

6. Once you have selected your financial institution from the list, click Next.
7. Type the username and password for your account at the selected financial institution.

Type your password a second time, and then click Next

8. Select the accounts held at the selected financial institution that you want to add to Port-

folioAnalyst. For example, you may have several different accounts at another financial

institution but you only want to add one of them to PortfolioAnalyst.
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Click the check box next to each account that you want to add.

For each account that you want to add, select the type of account: Investment:Brokerage or

Investment:Retirement. Click the down arrow to view the drop-down menu, and then make

your selections. Each type has several additional types associated with it. For example, you

can select Retirement and then select IRA as the type of Retirement.

9. If the account is successfully added, a confirmation screen opens that lists the account(s)

you just added, including the account ID and current balance.
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10. Click Close to stop adding accounts or Add More Accounts to add more external

accounts.

It usually takes until the next business day to load your external account portfolio data, which

you can see on the Summary tab.

Vewing and Editing External Accounts

The Manage Accounts screen lets you view and edit the external accounts that you have added

to PortfolioAnalyst.

To view and edit external accounts

1. Click Reports > PortfolioAnalyst.
2. Click the External Accounts tab.

Account Management Users' Guide 156

Chapter 3 Vewing and Editing External Accounts



Chapter 3 Vewing and Editing External Accounts

3. Click MANAGE ACCOUNTS.

All external accounts that you have added to PortfolioAnalyst are listed along with their

current balances. Icons on the right side of the display let you add or delete accounts

under each financial institution.

4. To change the account type of an external account:

o Click the down arrow on the left side of the account number whose type you want to

change. The account expands to display the current account type.
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o Use the drop-down menus to change the account type.
o Click Save when you have made all of your changes.

5. To add or delete accounts under a financial institution:

o Delete all accounts under a financial institution by clicking the red minus sign icon on

the financial institution row (the gray-colored row with multiple icons).
o Delete an individual account under a financial institution by clicking the minus sign

icon on the specific account row.
o To add an account under an existing financial institution, click the plus sign icon. You

will be prompted to add an account as described here.

6. To log in to an external account that you have added to PortfolioAnalyst, click the window

icon on the financial institution row (the last icon on the right). The login page for that

account will open in a new browser page.

Deleting External Accounts

You can easily delete external accounts from PortfolioAnalyst. For example, you may no longer

maintain an external account that you previously added.

To delete external accounts

1. Click Reports > PortfolioAnalyst.
2. Click the External Accounts tab.

3. To delete ALL external accounts from PortfolioAnalyst, click DELETE ALL ACCOUNTS.

Click Yes in the confirmation popup that opens to complete the operation.
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4. To delete individual accounts (for example, you may have added multiple accounts under

a specific financial institution but no longer maintain one of them):

o Click Manage Accounts.
o Clicking the red minus sign icon on the specific account row.
o In the confirmation popup, click Delete Institution to complete the operation.

Transaction Cost Analysis
Transaction Cost Analysis is a dynamic and interactive analysis of your trades marked to

various benchmarks grouped in different categories or on a per-order basis. Transaction Cost

Analysis applies to trades of any instrument type and is typically available ten minutes after a

trade is executed. Performance metrics are expressed as basis points (bps) of value traded.

Each executed trade in the period of the analysis is marked to a series of performance

benchmarks with the results displayed in multiple interactive tables. You can drill down in a

variety of categories, including trade date, order side, exchange, trade price and underlying, to

see how each trade performed when compared to the benchmark. The performance of a trade is

calculated by marking the trade price to each benchmark. A positive number indicates that the

trade worked in your favor; a negative number indicates that the trade did not work in your favor.

You can also add or remove columns from tables using the Configure Columns feature.

Combinations are not supported in the Transaction Cost Analysis.

See Understanding the Transaction Cost Analysis for a complete description of each column

heading and performance benchmark used in the analysis results.

Who can access the Transaction Cost Analysis page?

You can access this page if you have trading access and you have been granted Reporting

access rights.

To run a Transaction Cost Analysis

1. Click Reports > Transaction Cost Analysis.
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2. Select a start date and an end date from the From Date and To Date drop-down lists, then

click Submit to generate your analysis.

The page displays the results of your analysis in the Instrument Type and Marketability

section in the Summary Analysis. All performance numbers are in basis points, and

volume is in shares or contracts, as applicable. Negative numbers appear in parentheses.

Sort the data by any column by clicking the column heading.

Here is an example of transaction cost analysis Summary Analysis results.

3. Click a category (expanding items are indicated by a plus sign) to drill down to view more

detailed data by instrument type and marketability. Detailed results are displayed in addi-

tional tables:

o By Trade Date
o By Trade Side
o By Exchange
o By Trade Size
o By Trade Price
o By Underlying
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o By Order Live Time in Seconds
o By Order Type
o By Average Delta

In addition, an Outlier Analysis is added to the results in the bottom half of the screen. The

Outlier Analysis shows an analysis of the Top and Bottom orders for each of the

performance benchmarks. You can jump quickly to the Outlier Analysis from the link at the

top of the screen.

4. Filter the results further within each of the detailed breakdowns by clicking the appropriate

category.

5. Remove individual filters by clicking the X icon next to a filter link in the Current Active Fil-

ters display located at the top of the screen. You can remove any filter in any order at any

time. The report data refreshes to reflect the change in the Current Active Filters.

For example, suppose your Current Active Filters display looks like this:
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You remove the Trade Size: 500à 1000 filter by clicking the X icon to the left of the filter

link. The Current Active Filters changes to look like this (and the report data refreshes to

indicate the new Current Active Filters):

o To return to the original Summary Analysis table and remove all filters, click the X icon

next to Remove All in the Current Active Filters display.
o To choose a different date range, click Change Date Range in the upper right corner of

the page.

6. View detailed data for the orders in the current view by clicking the View Order Details link

at the top of the screen.

Click the Back link at the upper right corner of the screen to return to the original report

view. Order Details shows data only for the orders that are visible in the current view using

the current active filters. For example, if you are viewing all marketable stock orders and

there are 300 orders, the Order Details will include details for those 300 orders. If your cur-

rent active filters are showing only ten orders, then the Order Details will include details

for those ten orders.
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7. You can configure columns for the Summary Analysis table, for all of the detailed tables,

for the Outlier Analysis tables and for the Order Details table. When you configure

columns for the detail tables, your changes apply to all detail tables.

o Click the Configure Columns link located above and to the right of each configurable

table.

o All current columns are listed in the Columns Included box on the right. Columns that

you can add are listed in the Columns available box on the left. To add a column, click

the column name on the left to select it, and then click the green right-facing arrow to
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move the selected column name to the list of Columns Included. To remove a column,

click the column name on the right to select it, and then click the left-facing arrow to

move the selected column name to the list of Columns Available. You can select more

than one column name at a time using the Control+click keyboard-mouse combination.
o Click Save to update the tables with the modified columns.

When you log in for the first time, we display all columns by default. If you choose to

remove all columns, we will still display the default columns. Any changes applied to

Summary Analysis columns will also be applied to the Details table columns and vice

versa.

8. Optionally, print the current view of the report by clicking the Print link in the upper right

corner of the screen, including the Order Details page.

Understanding the Transaction Cost Analysis

Transaction Cost Analysis lets you analyze the cost of the decision to trade over a specified

time period with respect to various benchmarks.

Each executed trade in the period of the analysis is marked to a series of performance

benchmarks with the results displayed in multiple interactive tables. You can drill down in a

variety of categories, including trade date, order side, exchange, trade price and underlying, to

see how each trade performed when compared to the benchmark. The performance of a trade is

calculated by marking the trade price to each benchmark. A positive number indicates that the

trade worked in your favor; a negative number indicates that the trade did not work in your favor.

Marketability

Indicates whether an order was marketable or not. A marketable order is either a market order

or is an order that is bought at a price that is greater than or equal to the prevailing ask price (or

sold at a price that is less than or equal to the prevailing bid price) when the order is submitted.

Transaction Cost
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Every trade has costs associated with the transaction. There are explicit costs like commissions

and exchange fees etc, and there are implicit costs that depend primarily on the characteristics

of the trade relative to prevailing market conditions and trading strategy.

The Transaction Cost Analysis report compares trades to various industry standard

benchmarks and some unique measures, allowing you to evaluate the quality of the executions.

Basis Points

Unit of measure that describes the percentage change in the value or rate of a financial

instrument. One basis point = 0.01%, or 0.0001 in decimal form. Performance metrics are

expressed as basis points (bps) of value traded.

Currency

All commissions are in your account's base currency. When we add notional value and total

premium, those will also be in account's base currency. The trade price will stay in traded

currency.

Methodology

We mark each trade to a series of benchmarks such as price improvement, arrival price and

more. We aggregate trades weighted by volume and present overall performance as well as

various tables that show performance broken down by various criteria such as trade date, trade

price, underlying, exchange and more.

Negative numbers are indicated by parentheses.

You can drill down into reports by clicking categories, essentially filtering the results as

required; the current active filters are always displayed at the top of the page and you can

remove any individual filter by clicking the X icon next the filter. Detailed tables show data for

the following:

By Trade Date

By Trade Side

By Exchange

By Trade Size
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By Trade Price

By Underlying

By Order Live Time in Seconds

By Order Type

By Average Delta

You can also view the details of each order in the Order Details table, which opens on a new

page.

Outliers for each performance benchmark are displayed in the Outlier Analysis section, which

shows an analysis of the Top and Bottom symbols for all performance benchmarks.

Report Columns

The following table shows all of the columns in the Transaction Cost Analysis report and their

descriptions, including all of the performance benchmarks.

Column Definition

Orders Number of executed orders.

Total% In Detail views, this column follows the Orders

column. It shows the line item's percentage of

the total number of executed orders. For

example, in the By Trade Side breakdown,

suppose there are 40 Buy orders and 60 Sell

orders. The Total% of Buy orders would be 40,

or 40% of the total number of orders, and the

Total% of Sell orders would be 60, or 60% of the

total number of orders.

Trades Number of individual fills/executions.

Total% In Detail views, this column follows the Trades

column. It shows the line item's percentage of

the total number of fills/executions. For

example, in the By Trade Side breakdown,

suppose there are 232 trades that were Buys
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and 341 trades that were Sells. The Total% of

Buy trades would be 40.5, or 40.5% of the total

number of trades, and the Total% of Sell trades

would be 59.5, or 59.5% of the total number of

trades.

Qty Number of executed shares/contracts.

Total% In Detail views, this column follows the Quantity

column. It shows the line item's percentage of

the total number of shares or contracts

executed. For example, in the By Trade Side

breakdown, suppose there are 79,853 shares

traded that were Buys and 11,662 shares traded

that were Sells. The Total% of Buy shares

would be 40.5, or 40.5% of the total number of

shares traded, and the Total% of Sell shares

would be 59.5, or 59.5% of the total number of

shares executed.

Performance Benchmarks

Price Improvement Basis points that your orders were filled better

(worse) than then National Best Bid (for sell

orders) or Offer (for buy orders) at time each

order was submitted.

Arrival Price Basis points that your orders were filled better

(worse) than themidpoint of the National Best

Bid andOffer at time each order was submitted.

vs Trade +1min Basis points that your orders were filled better

(worse) than themidpoint of the National Best

Bid andOffer oneminute after each trade.

vs Trade +10min Basis points that your orders were filled better

(worse) than themidpoint of the National Best

Bid andOffer tenminutes after each trade.

vs Close Basis points that your orders were filled better
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(worse) than the Close price of each security on

the day the order was executed.

vs VWAP Basis points that your orders were filled better

(worse) than the VWAP (volumeweighted aver-

age price) for each order's security measured

between the time of each order's submission

and the time the order is completed or cancelled.

vs Daily VWAP Basis points that your orders were filled better

(worse) than the VWAP (volumeweighted aver-

age price) for each order's security measured

over the entire day of trading that the order was

executed.

vs Daily Range Percentage of today's High and Low price range

that the trade captured. For example, a buy at

the day's low captures 100% of the daily range.

This is calculated as the average across

included orders of:

Buy Orders: (Daily High - Execution Price) /

(Daily High - Daily Low)

Sell Orders: (Execution Price - Daily Low) /

(Daily High - Daily Low)

Fill Rates

Filled/Total Qty Average across included orders of:

Fill Quantity/Total Quantity.

Fill Rate/sec Average across included orders of:

Fill Quantity / Total Quantity per second.

Feasible Fill Rate Percentage of an order that could be filled con-

sidering the size available at the NBBO.

Commissions

Commission Sum of commissions for all included orders.

Account Management Users' Guide 168

Chapter 3 Understanding the Transaction Cost Analysis



Chapter 3 Risk

Commission/Share Average commission per share/contract.

Order Details

Ticker Symbol.

Submit Date The date on which the order was placed.

Submit Time The time at which the order was placed.

Time Zone Time zone for the order time.

Live Time Duration the order was live.

Type The order type (Market, Limit, etc.).

Side Identifies the order as a Buy or Sell.

Order Qty Order quantity.

Trades Number of individual fills/executions.

TradeQty Trade quantity.

Average Price Average trade price.

Risk
The Risk menu gives you access to the following reports:

Margin Reports

Stress Test Report

Value at Risk Report

Margin Reports

You can see real-time margin summary amounts displayed in the Account window in Trader

Workstation. For position margin requirements, however, you can view margin reports in

Account Management. At 16:15 ET each day, we record your margin and equity information for

positions across all asset classes and exchanges for the margin report.
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